# TABLE OF CONTENTS

PREFACE ................................................................................................................................. 6

INTRODUCTION ....................................................................................................................... 8

1. OVERVIEW ......................................................................................................................... 8

2. ARCHITECTURE ................................................................................................................. 8

3. OPC HDA SERVER FEATURES ...................................................................................... 9

3.1. OPC HISTORICAL DATA ACCESS CAPABILITIES ....................................................... 9
3.2. EASY INTERFACE FOR DATABASE CONFIGURATION ........................................... 12

4. OPC COMPATIBILITY ..................................................................................................... 12

5. SYSTEM REQUIREMENTS ............................................................................................. 12

GETTING STARTED .............................................................................................................. 14

1. PRE-INSTALLATION CONSIDERATIONS ................................................................ 14

2. INSTALLING OPC SERVER .......................................................................................... 14

3. SERVER REGISTRATION ............................................................................................... 15

4. REMOVING OPC SERVER ............................................................................................. 16

5. RUNNING OPC HDA SERVER AS NT SERVICE ......................................................... 17

6. LOGGING ........................................................................................................................ 20

CONFIGURATION ................................................................................................................ 24
1. INTRODUCTION ................................................................................................................ 24
2. SERVER CONFIGURATION ............................................................................................ 25
  2.1. CONFIGURING THE SERVER LINK ................................................................. 26
  2.2 CONFIGURING THE OBJECT LINK .............................................................. 36
  2.3 ITEM IDS SYNTAX ................................................................................................. 45
3. ALIAS CONFIGURATION ............................................................................................ 45
  3.1 CONFIGURING THE ALIAS GROUP ............................................................... 45
  3.2 CONFIGURING ALIASES ................................................................................ 47
  3.3 IMPORTING/EXPORTING ALIASES CONFIGURATION ....................................... 51
  3.4 ITEM IDS SYNTAX ................................................................................................. 51
4. GENERAL CONFIGURATION ........................................................................................ 52
  4.1 EXECUTING SQL SCRIPT .................................................................................... 52
  4.2 DATABASE RECOVERY ....................................................................................... 53
  4.3 SERVER/LOG SETTINGS ..................................................................................... 54
  4.4 VIEW CONFIGURATION ERRORS ........................................................................ 55
DCOM CONFIGURATION ....................................................................................................... 56
1. CONFIGURING THE SERVER FOR DCOM ................................................................. 56
2. CONFIGURING THE CLIENT FOR DCOM ................................................................. 61
TROUBLESHOOTING .............................................................................................................. 65
TIPS .............................................................................................................................................. 67
TABLE OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>System architecture</td>
<td>9</td>
</tr>
<tr>
<td>2</td>
<td>Program Menu</td>
<td>16</td>
</tr>
<tr>
<td>3</td>
<td>Start menu</td>
<td>18</td>
</tr>
<tr>
<td>4</td>
<td>Server menu</td>
<td>18</td>
</tr>
<tr>
<td>5</td>
<td>Control panel</td>
<td>19</td>
</tr>
<tr>
<td>6</td>
<td>About</td>
<td>19</td>
</tr>
<tr>
<td>7</td>
<td>GUI</td>
<td>25</td>
</tr>
<tr>
<td>8</td>
<td>Add server link (Default InSQL Connection)</td>
<td>26</td>
</tr>
<tr>
<td>9</td>
<td>Add Default InSQL Connection</td>
<td>27</td>
</tr>
<tr>
<td>10</td>
<td>Added Server Link</td>
<td>28</td>
</tr>
<tr>
<td>11</td>
<td>Table’s Settings</td>
<td>29</td>
</tr>
<tr>
<td>12</td>
<td>View added server link (Default InSQL Configuration)</td>
<td>30</td>
</tr>
<tr>
<td>13</td>
<td>Add server link (Custom InSQL Connection)</td>
<td>30</td>
</tr>
<tr>
<td>14</td>
<td>Add Custom InSQL Connection</td>
<td>31</td>
</tr>
<tr>
<td>15</td>
<td>Add table link</td>
<td>32</td>
</tr>
<tr>
<td>16</td>
<td>Configure Tags Window</td>
<td>33</td>
</tr>
<tr>
<td>17</td>
<td>Configure Table Window</td>
<td>34</td>
</tr>
<tr>
<td>18</td>
<td>View added server link (Custom InSQL Configuration)</td>
<td>35</td>
</tr>
<tr>
<td>19</td>
<td>Rename server link</td>
<td>36</td>
</tr>
<tr>
<td>20</td>
<td>New object link</td>
<td>37</td>
</tr>
<tr>
<td>21</td>
<td>Pre-configured table</td>
<td>38</td>
</tr>
<tr>
<td>22</td>
<td>Interpolation parameters</td>
<td>40</td>
</tr>
<tr>
<td>23</td>
<td>SQL query</td>
<td>42</td>
</tr>
<tr>
<td>24</td>
<td>Pre-configured table (Editing)</td>
<td>44</td>
</tr>
<tr>
<td>25</td>
<td>New Alias Group</td>
<td>46</td>
</tr>
<tr>
<td>26</td>
<td>Rename Group Alias</td>
<td>46</td>
</tr>
<tr>
<td>27</td>
<td>New Alias</td>
<td>47</td>
</tr>
<tr>
<td>28</td>
<td>Select an item</td>
<td>48</td>
</tr>
<tr>
<td>29</td>
<td>Select canonical data type</td>
<td>49</td>
</tr>
<tr>
<td>30</td>
<td>View Alias Properties</td>
<td>50</td>
</tr>
<tr>
<td>31</td>
<td>Rename Alias</td>
<td>50</td>
</tr>
<tr>
<td>32</td>
<td>Alias configuration menu</td>
<td>51</td>
</tr>
<tr>
<td>33</td>
<td>Alias configuration toolbar</td>
<td>51</td>
</tr>
<tr>
<td>34</td>
<td>Execute SQL script menu</td>
<td>52</td>
</tr>
<tr>
<td>35</td>
<td>Alias configuration toolbar</td>
<td>52</td>
</tr>
<tr>
<td>36</td>
<td>Execute SQL script</td>
<td>53</td>
</tr>
<tr>
<td>37</td>
<td>Configuration error: Executing SQL script</td>
<td>53</td>
</tr>
<tr>
<td>38</td>
<td>Database recovery menu</td>
<td>53</td>
</tr>
<tr>
<td>39</td>
<td>Database recovery settings</td>
<td>54</td>
</tr>
<tr>
<td>40</td>
<td>General settings</td>
<td>54</td>
</tr>
<tr>
<td>41</td>
<td>DCOM Config</td>
<td>57</td>
</tr>
<tr>
<td>42</td>
<td>Default Configuration</td>
<td>58</td>
</tr>
<tr>
<td>43</td>
<td>DCOM Configuration</td>
<td>59</td>
</tr>
<tr>
<td>44</td>
<td>Location</td>
<td>60</td>
</tr>
<tr>
<td>45</td>
<td>Security Tab</td>
<td>61</td>
</tr>
<tr>
<td>46</td>
<td>Default Security</td>
<td>62</td>
</tr>
<tr>
<td>47</td>
<td>Location</td>
<td>64</td>
</tr>
</tbody>
</table>
About this Guide

This guide:

- Describes the main features offered by Integration Objects’ OPC HDA Server for InSQL;
- Lists the system requirements for installing and running Integration Objects’ OPC HDA Server for InSQL;
- Explains how to configure this OPC HDA Server for database management;
- Explains how to use and run this OPC server;
- Explains how to run this server application as NT service;
- Describes all required DCOM settings both on server and client sides.

Audience

This document is intended for users looking for applications that provide connectivity to IndustrialSQL databases. Knowledge of the basics of OPC HDA (Historical Data Access) is assumed. It's also expected that you have some prior knowledge of InSQL database configuration and SQL queries.

Related Documentation

OPC Foundation (www.opcfoundation.org)

- OPC Historical Data Access

Wonderware

- IndustrialSQL documentation
# Customer Support Services

<table>
<thead>
<tr>
<th>Offices</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Houston, USA:</strong></td>
<td>Support: <a href="mailto:customerservice@integrationobjects.com">customerservice@integrationobjects.com</a></td>
</tr>
<tr>
<td>+1 713 609 9208</td>
<td></td>
</tr>
<tr>
<td><strong>Genova, Italy:</strong></td>
<td>Sales: <a href="mailto:sales@integrationobjects.com">sales@integrationobjects.com</a></td>
</tr>
<tr>
<td>+39 34 75 83 93 47</td>
<td></td>
</tr>
<tr>
<td><strong>Tunis, Tunisia:</strong></td>
<td>Online: <a href="http://www.integrationobjects.com">www.integrationobjects.com</a></td>
</tr>
<tr>
<td>+216 71 861 803</td>
<td></td>
</tr>
</tbody>
</table>
INTRODUCTION

1. OVERVIEW
Integration Objects’ OPC HDA Server for InSQL is a PC-based software application that is designed to offer full access to archived data monitored by the InSQL database systems to any OPC HDA client.

This chapter contains the following parts:
- First, we present a global architecture showing the interaction between this OPC server, OPC clients and the various supported databases in a client/server environment.
- Second, we describe all OPC Historical Data Access interfaces supported by this server.
- Finally, we enumerate software and hardware system requirements.

2. ARCHITECTURE
The OPC HDA Server for InSQL reads and updates data from/to the historian database via ADO (Active Data Objects) technology. It can be accessed locally or remotely via DCOM by any OPC HDA client.

The following figure describes a Client/Server architecture that shows the interaction between OPC HDA clients, OPC HDA servers and databases.
This OPC HDA Server communicates with InSQL (IndustrialSQL) via ADO technology using the required OLE DB Provider.

3. OPC HDA SERVER FEATURES

This section describes and enumerates features offered by this OPC HDA Server including OPC HDA services and server/database configuration.

3.1. OPC HISTORICAL DATA ACCESS CAPABILITIES

This OPC HDA Server allows any HDA client to retrieve simple and processed data from the pre-configured database. Simple data retrieval includes raw reads and reads at time. However, summary data is computed using analysis functions such as average, interpolation, etc. Historical data can also be updated. You can insert new data or
replace existing raw(s) (checking the timestamp of the HDA item). You can also delete raw(s) for a specified time or during a time range when required.

For more details, you can refer to the "OPC HDA Fundamentals.pdf" delivered in the package (see the “Integration Objects\Integration Objects' OPC HDA Server for InSQL\Documents” directory under the Program Files folder).

Following are the currently supported HDA interfaces.

<table>
<thead>
<tr>
<th>Object</th>
<th>Interface</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPCHDAServer</td>
<td>IOPCCCommon</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_Server</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_SyncRead</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_SyncUpdate (optional)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_SyncAnnotations (optional)</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_AsyncRead (optional)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_AsyncUpdate (optional)</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_AsyncAnnotations (optional)</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>IOPCHDA_Playback (optional)</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>IConnectionPointContainer</td>
<td>Yes</td>
</tr>
</tbody>
</table>

| OPCHDABrowser| IOPCHDA_Browser            | Yes |

This server does not support the annotations and playback interfaces of the HDA standard, both of which are optional interfaces.

- **Supported attributes**
  These are the standard HDA attributes supported by the server:
  - OPCHDA_DATA_TYPE: Specifies the data type for the item.
  - OPCHDA_ITEMID: Specifies the item id.

- **Supported aggregates**
  This server supports the following standard aggregates defined by the OPC Foundation¹:

¹ Aggregates descriptions are taken from the “Historical Data Access Custom Interface Standard version 1.1” specification provided by OPC Foundation.
- **OPCHDA_AVERAGE**: the average data over the resample interval.
- **OPCHDA_TOTAL**: the totalized value (time integral) of the data over the resample interval.
- **OPCHDA_COUNT**: the number of raw values over the resample interval.
- **OPCHDA_INTERPOLATIVE**: used for retrieving interpolated values.
- **OPCHDA_START**: the value at the beginning of the resample interval. The time stamp is the time stamp of the beginning of the interval.
- **OPCHDA_TIMEAVERAGE**: the time weighted average data over the resample interval.
- **OPCHDA_STDEV**: the standard deviation over the resample interval.
- **OPCHDA_MINIMUMACTUALTIME**: the minimum value in the resample interval and the timestamp of the minimum value.
- **OPCHDA_MINIMUM**: the minimum value in the resample interval.
- **OPCHDA_MAXIMUMACTUALTIME**: the maximum value in the resample interval and the timestamp of the maximum value.
- **OPCHDA_MAXIMUM**: the maximum value in the resample interval.
- **OPCHDA_END**: the value at the end of the resample interval. The time stamp is the time stamp of the end of the interval.
- **OPCHDA_DELTA**: the difference between the first and last value in the resample interval.
- **OPCHDA_REGSLOPE**: the slope of the regression line over the resample interval.
- **OPCHDA_REGCONST**: the intercept of the regression line over the resample interval. This is the value of the regression line at the start of the interval.
- **OPCHDA_REGDEV**: the standard deviation of the regression line over the resample interval.
- **OPCHDA_VARIANCE**: the variance over the sample interval.
- **OPCHDA_RANGE**: the difference between the minimum and maximum value over the sample interval.
- **OPCHDA_DURATIONGOOD**: the duration (in seconds) of time in the interval during which the data is good.
- **OPCHDA_DURATIONBAD**: the duration (in seconds) of time in the interval during which the data is bad.
- **OPCHDA_PERCENTGOOD**: the percent of data (1 equals 100 percent) in the interval which has good quality.
- **OPCHDA_PERCENTBAD**: the percent of data (1 equals 100 percent) in the interval which has bad quality.
- **OPCHDA_ANNOTATIONS**: the number of annotations in the interval.
- **OPCHDA_WORSTQUALITY**: the worst quality of data in the interval.

### 3.2. Easy Interface for Database Configuration
Integration Objects’ OPC HDA server for InSQL offers an intuitive graphical user interface to manage the supported databases. This configuration tool aims to configure tag IDs, data types, access rights, start bound, end bound, etc. Database configuration should be saved in an XML file for the next OPC HDA Server launch (configured tags are not added at runtime). The user can also Import/Export tag configurations from/to a CSV file.

At server start-up, it loads the configuration file to create tags and build its address space. The server also retrieves all database information like table names and matching between tag and column names to allow transactions from the server to the database.

### 4. OPC Compatibility
Integration Objects’ OPC HDA Server for InSQL implements the OPC Historical Data Access (HDA) specifications version 1.1 and 1.2.

### 5. System Requirements
- This application was successfully installed and executed under the following operating systems: Windows Server 2008, Windows Seven, Windows Server 2003, Windows XP.
- Installing and running the application should be using administrator account
- You need a compliant IndustrialSQL Server 9, 10, 2012 or 2012 R2 installation in your network
- Required OPC DLLs (described in more details in the next chapter).
- An OPC HDA client compliant with OPC HDA 1.1 and 1.2 standards (Integration Objects’ OPC HDA clients are available through the following link: http://www.integrationobjects.com).
GETTING STARTED

1. PRE-INSTALLATION CONSIDERATIONS
First of all, you have to install the OPC Proxy/Stub DLLs. These DLLs are opccomn_ps.dll, opcproxy.dll and opchda_ps.dll.
These files are available for download from the OPC Foundation web site. You can follow this link to download the OPC core Components:

These DCOM proxy/stub libraries are copied on the target system under the "system32" folder.
They should be registered:
- automatically: if you installed them from OPC core components without any problem
- manually: by using the regsvr32 command as shown below:

Example (Windows XP)
/regsvr32 "C:\WINDOWS\system32\opcproxy.dll" (if your system drive is “C:”)
/regsvr32 "C:\WINDOWS\system32\opccomn_ps.dll"
/regsvr32 "C:\WINDOWS\system32\ opchda_ps.dll"

2. INSTALLING OPC SERVER
The following are the required steps to install the OPC HDA Server for InSQL:
1. Double click on OPCHDAServerForInSQL.exe. The installation will start automatically.
2. Follow the installer wizard as it guides you through the rest of the installation.
3. If you want to install this OPC HDA Server as an NT service, check the "**Install as NT service?**" option.

The installation copies all necessary files to the target folder, creates a shortcut icon to invoke the OPC HDA Server in the Start menu and makes an un-installation entry in the Add/Remove Programs Window in the Control Panel.

For remote connection to this OPC server, you can apply the following registration files copied in the “Integration Objects\Integration Objects’ OPC HDA Server for InSQL\Reg Files” directory under the Program Files folder:


### 3. SERVER REGISTRATION

In compliance with the OPC and COM specifications, the OPC HDA Server for InSQL creates the following registry entries under HKEY_CLASSES_ROOT when installed on the target system. These entries are removed when the server is uninstalled:

<table>
<thead>
<tr>
<th>Registry Key</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>IntegrationObjects.OPCHDA.InSQL</td>
<td>Integration Objects OPC HDA Server for InSQL; <a href="http://www.integrationobjects.com">http://www. integrationobjects.com</a></td>
</tr>
<tr>
<td>IntegrationObjects.OPCHDA.InSQL \CLSID</td>
<td>{CLSID} = {682B0E0D-C1F8-4d46-914B-D24CCD667246}</td>
</tr>
<tr>
<td>CLSID{CLSID}</td>
<td>Integration Objects OPC HDA Server for InSQL; <a href="http://www.integrationobjects.com">http://www. integrationobjects.com</a></td>
</tr>
<tr>
<td>CLSID{CLSID}\AppID</td>
<td>{CLSID}</td>
</tr>
<tr>
<td>CLSID{CLSID}\Implemented Categories{7DE5B060-E089-11d2-A5E6-000086339399}</td>
<td>Historical Data Access Specification 1.1</td>
</tr>
<tr>
<td>CLSID{CLSID}\LocalServer32</td>
<td>Path to server executable (OPCHDAInSQL.exe).</td>
</tr>
<tr>
<td>CLSID{CLSID}\ProgID</td>
<td>IntegrationObjects.OPCHDA.InSQL</td>
</tr>
</tbody>
</table>
MANUAL REGISTRATION

The OPC HDA Server can also be registered manually using command-line parameters for the server executable in a DOS Window:

[-RegServer] or [/RegServer]

This adds the necessary entries into the system registry.

For example, in the command prompt window, you type:

Prompt> OPCHDAInSQLService.exe –RegServer

*Prompt* is the path of the target directory where the OPCHDAInSQL.exe is located.

4. Removing OPC Server

You can manually remove all registry information related to this OPC HDA Server by using one of the following command-line parameters:

[-UnregServer] or [/UnregServer]

To properly remove the server from your machine, close all OPC HDA Server applications and documents. To do it automatically, just click the **Uninstaller** short-cut icon in the Start menu.

![Program Menu](image)

*Figure 2: Program Menu*

The OPC HDA Server can also be removed manually as follows:

1. Click **Start**.
2. Click **Settings**.
3. Click **Control Panel**.
4. Click **Add/Remove Programs**.
5. In Add/Remove Programs dialog screen select “Integration Objects OPC HDA Server for InSQL”.

6. Click Change/Remove, then OK.

The software will be removed with all registry entries and shortcuts created by the installation.

5. RUNNING OPC HDA SERVER AS NT SERVICE

During the server installation, the setup wizard gives you the option to install and manage the OPC HDA Server as a service instead of a local executable. If you skipped this option for later on, you can register it manually by using one of the following command line parameters:

[SERVICE] or [-SERVICE]

For example, in the command prompt window, you type:

Prompt> OPCHDAInSQLService.exe /SERVICE

Prompt is the path of the target directory where the OPCHDAInSQL.exe is located.

A new service is added with service name “Integration Objects’ OPC HDA Server for InSQL Service”.

This call registers the server to run automatically during Windows start-up. Next, you may be required to configure your service by means of the Service Control Manager. You can then unregister it by using one of the following command line parameters:

[UNSERVICE] or [–UNSERVICE]

For example, in the command prompt window type:

Prompt> OPCHDAInSQLService.exe /UNSERVICE

Prompt is the path of the target directory where the OPCHDAInSQL.exe is located.

Note that in this case (running as NT service) the OPC server’s GUI does not show up. The OPC HDA Server for InSQL can be started manually from the OPC server’s shortcut in the Programs menu or activated dynamically when an OPC HDA client is connecting or by the service control manager if it is running as an NT service.
To start the OPC HDA Server manually, click on Start ➔ Programs ➔ Integration Objects ➔ OPC HDA Server for InSQL ➔ OPC HDA Server for InSQL

![Start menu](image)

Figure 3: Start menu

If the server is not currently running, COM will attempt to launch it when the first client attempts to connect to it.

If it runs as a local executable when starting, a small icon appears in the tool tray at the right-hand side of the Task Bar.

In some cases, when a remotely connecting client tries to launch the OPC server, the OPC server’s GUI (if it runs as an executable) does not show up. This is due to your DCOM configuration. You should set the Identity for your OPC HDA Server to “The interactive user”.

Right click on the icon to display the following menu.

![Server menu](image)

Figure 4: Server menu

Click **Show Control Panel** to display the control panel for the server (Figure 4). The control panel displays general statistics for the server, such as the number of clients currently connected. It also displays the status of the server. The server state can be RUNNING or SUSPENDED.
Click **Shutdown** to stop the OPC server.

Click **About** from the menu to display the About Box for the server. The About Box contains the server name and version number as well as other information about the software and Integration Objects. This about box looks like:

![Integration Objects](image)

**Figure 6**: About

Click **Contact us** to get helpful links or to ask for further information about this product and Integration Objects.

Click **Configure** to configure this server (the next chapter explains in details this server functionality).
6. LOGGING

The OPC HDA Server for InSQL produces a log file named “DBSrv_LogEvent.LOG” that records errors and debugging information for the server. As this server is based on Integration Objects’ OPC HDA Server DLL (DXServerDll.dll), you can view all logged DLL events in a separate file “SrvToolkit_LogEvent.LOG” for easy diagnostics. If difficulties occur with the server, the log files can be extremely valuable for troubleshooting. Under normal operations, the server logs very little information. These log files are generated at start-up under the setup folder where the OPCHDAInSQL.exe is located.

This OPC HDA Server incorporates a configuration file “DBSrv_CfgFile.ini” which includes several logging parameters, a timing parameter (used to improve the performance of the server) and some database recovery parameters. All these parameters have default settings and can be changed at start-up by editing the configuration file or using the server GUI.

To change this file:
1. Open DBSrv_CfgFile.ini in a text editor.
2. Edit any of the parameters listed in the following tables:

Or you can update these parameters through the GUI of the server.

<table>
<thead>
<tr>
<th>Log Setting</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogFileMaxSize</td>
<td>The maximum log file size, in bytes. Once this size is reached during run-time, the log file is overwritten.</td>
<td>1048576*2 (~ 2 Mo)</td>
</tr>
<tr>
<td>LogLevel</td>
<td>The log level. Possible Values are:</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>0: Only fatal error messages are logged.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1: All critical error messages are logged.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2: All errors are logged.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3: All warnings are logged.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4: All information is logged.</td>
<td></td>
</tr>
</tbody>
</table>
5: For Debug information. The higher the log level is, the more information is recorded. We recommend using level 0 for a better performance of the server.

| ArchiveLastLog | TRUE: Old file is copied to an intermediate file with incremental extension, before being overwritten. FALSE: Any pre-existing log file is erased and overwritten at start-up. | FALSE |
| LoadConfigOnStartUp | TRUE: the server configuration will be loaded at OPC HDA Server start-up. FALSE: the server starts without loading configuration file (no tags in the server address space). | TRUE |
| ConfigFilePath | The full path of the server configuration file for the database. |

<table>
<thead>
<tr>
<th>PerfParameters</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SERVER_RATE</td>
<td>This parameter is the frequency at which the server handles the asynchronous reads/updates.</td>
<td>250 ms (milliseconds)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DBRecovery</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>sCycle</td>
<td>This parameter is the frequency at which the server checks for the database connection state.</td>
<td>30 s (seconds)</td>
</tr>
<tr>
<td>DBLogFile</td>
<td>The full path of the logging file for tracing database problems.</td>
<td></td>
</tr>
</tbody>
</table>
3. Save the file for the settings to take effect.

**SAMPLE CONFIGURATION FILE**

```ini
[LogSetting]
LogFileMaxSize=2097152
LogLevel=0
ArchiveLastLog=FALSE
LoadConfigOnStartUp=TRUE
ConfigFilePath=C:\Program Files\Integration Objects\Integration Objects' OPC HDA Server for InSQL\Config.xml

[PerfParameters]
Server_Rate=250

[DBRecovery]
sCycle=30
DBLogFile=C:\Program Files\Integration Objects\Integration Objects' OPC HDA Server for InSQL\DBRecovery_LogEvent.LOG

[InSQLSetting]
UseHistoryMode = TRUE
wwRetrievalMode = DELTA
UseBounds = TRUE
OPENQUERY = FALSE
SQLVERSION = 2008
```
You may change configuration parameters in the toolkit configuration file “SrvToolkit_CfgFile.ini”. You may increase or decrease the trace level.

DATABASE LOGGING

All database connection problems are recorded in a configuration file that allows you to customize its full path (by default DBRecovery_LogEvent.LOG under the setup folder).
1. INTRODUCTION
Users can configure this server with an intuitive GUI (Graphical User Interface) database management.

We distinguish these main sections:
- Server Configuration: describes how to configure server object links to InSQL database.
- Alias Configuration: user has the possibility to configure alias names for tags with complicated identification.
- General Configuration: contains server logging parameters and database recovery settings used once the connection is lost.

The main window consists of a menu bar, a toolbar and two sub-views (a tree view and a list view).
2. SERVER CONFIGURATION

The main tree view for this server interface is composed of two main nodes: Server configuration and Alias configuration. Select one object under one of these nodes to display its current configuration.
2.1. Configuring the Server Link
This section describes server link management: add, remove, enable/disable, connect, view configuration and edit the current configuration.

Adding a Server Link and Connecting to the Database
To add a server link, you can choose either custom or default mode. Select the “Server Configuration” node, right-click and select:

- New Default InSQL Connection: for default connection configuration
- New Custom InSQL Connection: for custom connection configuration

For each mode, every server link has a link to InSQL databases using the appropriate connection string. This OPC HDA Server uses ADO technology to manage the requested databases.

✓ Default InSQL Connection

![Figure 8: Add server link (Default InSQL Connection)](image)

When you click on “New Default InSQL Connection”, you will get the following screen:
The following are the connection parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>InSQL Name</strong></td>
<td>A custom name of the connection</td>
</tr>
<tr>
<td><strong>InSQL Connection description</strong></td>
<td>A custom description of the connection</td>
</tr>
<tr>
<td><strong>Server Name</strong></td>
<td>The server name: you have to select/enter the SQL Server associated with the IndustrialSQL (the HostName or the IP Address)</td>
</tr>
<tr>
<td><strong>Connection properties</strong></td>
<td>• Windows authentication</td>
</tr>
<tr>
<td></td>
<td>• InSQL authentication: in this case, you should type the login/password parameters.</td>
</tr>
<tr>
<td></td>
<td>When the IndustrialSQL Server is installed, default login IDs are</td>
</tr>
</tbody>
</table>

Figure 9: Add Default InSQL Connection
created. You can use them for logging on to the IndustrialSQL Server from the OPC HDA Server application such as (aaAdmin,pwAdmin) and (aaUser, pwUser). For further information about these pre-configured login IDs, please refer to the “IndustrialSQL Server Default Login IDs” section in the IndustrialSQL documentation.

- Connection time out: maximum duration to wait before the attempt expires
- Query Execution timeout: maximum duration to wait before the query execution expires

| Database Name | The name of the database by default it is “Runtime” |

After clicking the Apply button, The HDA Server for InSQL will be connected to the INSQL Server and it retrieves automatically the default preconfigured data tables. The new server link is added as follows:

![Figure 10 : Added Server Link](image)

During the connection, a default mapping is done in background. To change the tags’ settings, click Edit (right click menu). You will get the following screen:
Once the connection to the database is established, the server link state is set to **Connected** as follows:
Figure 12: View added server link (Default InSQL Configuration)

- Custom InSQL Connection

Figure 13: Add server link (Custom InSQL Connection)

When you click on **New Custom InSQL Connection**, you will get the following screen:
The following are the connection parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>InSQL Connection Name</td>
<td>A custom name of the connection</td>
</tr>
<tr>
<td>InSQL Connection Description</td>
<td>A custom description of the connection</td>
</tr>
<tr>
<td>Server name</td>
<td>The server name: you have to select/enter the SQL Server associated with the IndustrialSQL (the HostName or the IP Address)</td>
</tr>
</tbody>
</table>
| Connection properties | • Windows authentication  
                          • InSQL authentication: in this case, you should type the login/password parameters.  
                          When the IndustrialSQL Server is installed, default login IDs are
created. You can use them for logging on to the IndustrialSQL Server from the OPC HDA Server application such as (aaAdmin, pwAdmin) and (aaUser, pwUser). For further information about these pre-configured login IDs, please refer to the “IndustrialSQL Server Default Login IDs” section in the IndustrialSQL documentation.

- Connection time out: maximum duration to wait before the attempt expires
- Query Execution timeout: maximum duration to wait before the query execution expires

| Database Name | The name of the database by default it is “Runtime”

After clicking the **Apply** button, the Server link will be added. Then, you click on **New** (right click menu) to add a link to a preconfigured table.

You will get the following screen:
Click on Next. You will get the following screen:
When you select a table name from the combo box, the HDA Server maps automatically each tag’s attribute with the appropriate column if the column name is similar to the default attribute name. Otherwise, you need to configure the field according to your database documentation.

Once the connection to the database is established, the server link state is set to **Connected**. Click **View** to view server link configuration.
ENABLING/DISABLING A SERVER LINK
To allow object link management, enable your configured server link. You can enable your server link in two ways:

1- Check the “Enable server link” option when adding the server link.
2- Right-click on the selected server link node and click the Enable menu item.

To disable it, right-click the selected server link node and click the Disable menu item.

EDITING A SERVER LINK
To modify server settings, click Edit (right click menu). You will get the same screen as the “New Default/Custom Connection” one.
You can modify the following settings:

- Server link name.
- Server link description.
- Enabling/disabling the server link.
- Authentication parameters : either Windows authentication or the login and password for the remote access

RENAMING A SERVER LINK
If you only want to change the server link name, click Rename (right click menu). You will get the following screen:
DELETING A SERVER LINK

To remove a server link, click **Delete** (right click menu). This will remove all object links configured under this server link.

DELETING ALL...

To remove all configured object links under the selected server link, click the **Delete All...** menu item (right click menu).

2.2 CONFIGURING THE OBJECT LINK

This section describes the object link management: add, remove, enable/disable, view configuration and edit the current configuration.

ADDING AN OBJECT LINK

Select the server link node to which you want to add an object link (under the “Server configuration” node), right-click and select “**new**”.
Figure 20: New object link

1st step: Select a method for matching column names with OPC tag attributes

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object name</td>
<td>The object link name.</td>
</tr>
<tr>
<td>Object description</td>
<td>The object link description.</td>
</tr>
</tbody>
</table>
| Method of tag configuration | • Select a pre-configured table.  
|                           | • Formulate your SQL query.                      |

2nd step: Matching column names with OPC tag attributes
There are two ways to map tag attributes with column names:
- You can use a pre-configured table. In this case, the table should be already created.
- You can also formulate your SQL query.
  - Pre-configured table
You should select the first option “Select a Pre-configured Table” under the “Tags Configuration” section.

You need to select a table name from the list box or you enter a known table name. You can then match OPC tag attributes including ‘Tag Name’, ‘Tag Value’, ‘Tag Timestamp’ and ‘Tag Quality’ with column names of the selected table. Note that filling in the ‘Tag Name’, ‘Tag Value’ and ‘Tag Timestamp’ fields is mandatory. The selected columns should also be distinct. Otherwise, the object is rejected.

Since the InSQL system supports versioned data, in addition to tag attributes configuration, you should configure the value version (for further information, please refer to IndustrialSQL documentation).

Figure 21: Pre-configured table
The following table describes the configuration parameters displayed in the above dialog screen:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table name</td>
<td>The selected table name.</td>
</tr>
<tr>
<td>Tag Name</td>
<td>Select a column from the selected table from which the tag name will be collected.</td>
</tr>
<tr>
<td>Tag Value</td>
<td>Select a column from the selected table from which the tag value will be collected.</td>
</tr>
<tr>
<td>Tag Timestamp</td>
<td>Select a column from the selected table from which the tag timestamp will be collected.</td>
</tr>
<tr>
<td>Tag Quality</td>
<td>Select a column from the selected table from which the tag quality will be collected.</td>
</tr>
<tr>
<td>Tag Type</td>
<td>Select a column from the selected table from which the tag type will be collected.</td>
</tr>
<tr>
<td>Version</td>
<td>The column should be wwVersion. The value can be LATEST or ORIGINAL.</td>
</tr>
<tr>
<td>Retrieval Mode</td>
<td>The column name is wwRetrievalMode default value is “DELTA”.</td>
</tr>
<tr>
<td>Start Bound</td>
<td>The start bound used in HDA reads. This is an optional configuration parameter.</td>
</tr>
<tr>
<td>End Bound</td>
<td>The end bound used in HDA reads. This is an optional configuration parameter.</td>
</tr>
</tbody>
</table>

**Example:**
After selecting a table name, all fields will be activated. For each tag attribute, you can change the column name that you want.

**NB:** There are four tables where historian Data is archived, which are: history, AnalogHistory, DiscreteHistory and StringHistory. It is recommended that you create a link for each one of them.

**REFRESH TABLE NAMES LIST**
To refresh the table names available on the selected InSQL database, click the **Refresh** button.

**BOUNDING**
This is optional.
You can select the start and end time that will be used in HDA reads.

**INTERPOLATION**
This is optional.
You can customize the time range for Read at time requests concerning interpolated values. The time range is \([ftReadAtTime - Interpol, ftReadAtTime + Interpol]\) with \(ftReadAtTime\) the filetime argument passed in the ReadAtTime request and Interpol is the configured time range.

\[
\text{Interpol} = x_1Y + x_2D + x_3H + x_4MN + x_5S.
\]

\(Y\): year.
\(D\): day.
\(H\): hour.
\(MN\): minute.
\(S\): second.

Interpolation parameters:

<table>
<thead>
<tr>
<th>Interpolation</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
<th>0</th>
</tr>
</thead>
</table>

*Figure 22: Interpolation parameters*

**Example:**

\[
\text{Interpol} = 0Y + 0D + 1H + 0MN + 0S.
\]

**VERSIONED DATA**
The InSQL supports the versioning data feature. That means, for a given tag at the same timestamp, you can find a set of values for a specific version (‘ORIGINAL’ or ‘LATEST’).

- **SQL query**
You should select the second option “Formulate your SQL query” under the “Tags Configuration” section.
You can enter any type of SQL query (CREATE, SELECT, INSERT, UPDATE …). Only “SELECT” queries are considered for column mapping. Note that conditions in the SELECT query are ignored (example: SELECT * FROM Test WHERE (condition1) → condition1 is ignored). You can then match OPC tag attributes including ‘Tag Name’, ‘Tag Value’, ‘Tag Timestamp’, ‘Tag Quality’ and ‘Value Version’ with the selected column names.

You enter your SQL query in the edit text. Then, click the Execute button. Error messages are displayed in the edit text (“Success” for succeeded queries).

⚠️ For InSQL, SQL queries have a specific syntax. Please refer to the InSQL documentation.

Example:

SQL query = “SELECT * FROM History WHERE TagName LIKE ‘%’ AND TagName NOT LIKE ‘’.”
ENABLING/DISABLING AN OBJECT LINK

To allow HDA reads/updates to tags related to an object link, enable your configured object link. You may right-click on the selected object link node or click the **Enable** menu item.
To disable it, right-click the selected object link node and click the **Disable** menu item.

**EDITING OBJECT LINK**

You may change your configuration for an Object link. Click **Edit** (right click menu) from the selected Object link.

- **Pre-configured table**

  You can modify your configuration for an object link created using a pre-configured table. You will get the following screen:
Figure 24: Pre-configured table (Editing)

- SQL query
You can modify your configuration for an object link created using an SQL query. You will get the same dialog screen as adding an object link with one difference: the “Save Old Settings” button is activated.

**SAVING OLD COLUMNS MAPPING**

You may keep your old settings for mapping tag attributes with column names.

### 2.3 Item IDs Syntax

The slash “/” character is the separator used for item IDs in this OPC server. A full tag name is defined as follows:

```
Server_Link/Type_Of_Method/Object_Link/Column_Name_Value
```

Possible values for “Type_Of_Method” are “QUERY” and “CONFIGUREDTABLE”.

(Ex. Link_1/QUERY/Object_1/tag1).

### 3. Alias Configuration

Alias configuration is an option offered by Integration Objects’ OPC HDA Server for InSQL to avoid use of complicated full names for tags. Each alias name matches an item path in the configured tag tree for the “Server Configuration” node. You may configure one or more alias names for the same item path.

#### 3.1 Configuring the Alias Group

Alias names are gathered in groups.

**Adding Group Alias**

To add a new group alias, select the “Alias Configuration” node from the tree view. Then, click the **New** menu item (right click menu). You will get the following dialog screen:
RENAMING GROUP ALIAS

If you only want to rename the group name, click Rename (right click menu). You will get the following screen:

Figure 26 : Rename Group Alias

DELETING GROUP ALIAS

To remove a group alias, click Delete (right click menu). This will remove all aliases configured under this group.

DELETING ALL...

To remove all configured aliases under the selected group alias, click the Delete All... menu item (right click menu).
3.2 CONFIGURING ALIASES

ADDING AN ALIAS

Select the group alias node to which you want to add an alias (under the “Alias configuration” node), right-click and select “new”. You will get the following dialog screen:

![New Alias Configuration Dialog](image)

**Figure 27**: New Alias

BROWSE CONFIGURED ITEMS TREE

To select an item path from the available items’ tree for the configured alias, click the **Browse** button. You will get the following screen:
Figure 28: Select an item

REFRESH TABLE NAMES LIST

To refresh the available items’ tree, click the Refresh button.
Figure 29: Select canonical data type

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias name</td>
<td>The alias name.</td>
</tr>
<tr>
<td>Item Path</td>
<td>The item path.</td>
</tr>
<tr>
<td>Canonical data type</td>
<td>Item values returned to the OPC client will be coerced to use this data type.</td>
</tr>
<tr>
<td>Read Only</td>
<td>If you want to prevent OPC client applications from writing to this tag, you can check this option.</td>
</tr>
</tbody>
</table>

**Canonical data type**

Only simple types are available for the current version of this OPC server. You may select one of the following data types:

<table>
<thead>
<tr>
<th>Displayed data type</th>
<th>VARIANT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Byte</td>
<td>VT_UI1</td>
</tr>
<tr>
<td>Short</td>
<td>VT_I2</td>
</tr>
<tr>
<td>Long</td>
<td>VT_I4</td>
</tr>
<tr>
<td>Float</td>
<td>VT_R4</td>
</tr>
</tbody>
</table>
Once the add operation succeeds, the tree view and the list view are updated as follows:

<table>
<thead>
<tr>
<th>Date</th>
<th>VT_DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Double</td>
<td>VT_R8</td>
</tr>
<tr>
<td>String</td>
<td>VT_BSTR</td>
</tr>
<tr>
<td>Int</td>
<td>VT_INT</td>
</tr>
<tr>
<td>Unsigned Int</td>
<td>VT_UINT</td>
</tr>
<tr>
<td>Unsigned short</td>
<td>VT_UI2</td>
</tr>
<tr>
<td>Unsigned long</td>
<td>VT_UI4</td>
</tr>
<tr>
<td>Boolean</td>
<td>VT_BOOL</td>
</tr>
<tr>
<td>Char</td>
<td>VT_I1</td>
</tr>
</tbody>
</table>

"(Default)" type is the default type of the item path.

RENAMEING ALIAS

If you only want to rename the alias, click Rename (right click menu). You will get the following screen:

EDITING ALIAS

You may change configuration parameters for an alias. To do this, click the Edit menu item for the selected alias. You will get the same dialog screen as adding an alias.
DELETING ALIAS

To remove an alias, click the Delete menu item.

3.3 IMPORTING/EXPORTING ALIASES CONFIGURATION

You may import/export your alias configuration stored in a CSV file. To do so, click the Alias Configuration menu (Figure 34).

![Figure 32: Alias configuration menu](image)

Or, you can click on the toolbar as follows:

![Figure 33: Alias configuration toolbar](image)

When importing a CSV file, your current alias configuration will be replaced by the loaded one.

CSV FILE FORMAT

Comma-delimited text file (CSV) contains, in each line, a record that is composed of a set of fields. Fields are separated by a Comma mark. Each field is an alias attribute.

- Group,
- Alias,
- ItemPath,
- DataType,
- ReadOnly.

3.4 ITEM IDS SYNTAX

Remember that the slash “/” character is the separator used for item IDs in this OPC server.

A tag is defined as follows:
4. GENERAL CONFIGURATION

Integration Objects’ OPC HDA Server for InSQL provides you with a general configuration screen. General configuration includes the following main features:

- You may need to execute some SQL script to create your tables and populate them with rows before configuring server and object links.
- The database connection may be lost at server start-up or during server running. This OPC HDA Server incorporates a database recovery mechanism to restore lost connections.
- This OPC HDA Server supports event logging. This feature can be configurable. You may set some logging parameters.

4.1 EXECUTING SQL SCRIPT

You can execute any SQL script to create all needed tables. To do so, click the Options menu followed by the Execute SQL script menu item (Figure 36).

![Execute SQL script menu](image1)

Figure 34: Execute SQL script menu

Or, you can click on the toolbar as follows:

![Alias configuration toolbar](image2)

Figure 35: Alias configuration toolbar

You will get the following dialog screen:

Configured Aliases/Group_Alias/Column_Name_Value
(Ex. Configured Aliases /Group_1/tag1).
First off, enter a valid link name (already connected to a database). Then, enter the full path of an SQL script (*.sql) or click the browse button to show a file dialog screen that allows you to select the script file. Then, click the **Execute** button to execute the SQL script file. If errors occur while executing this script, you will get a dialog with an error icon like the following:

**Figure 37 : Configuration error: Executing SQL script**

If you want to view the log event file for script execution, click **Yes**.

### 4.2 DATABASE RECOVERY

You can customize database recovery parameters. To do so, click on the “Options” menu ➔ “Database” menu item ➔ “Database Recovery” sub menu item (see Figure 40).

**Figure 38 : Database recovery menu**
You will get the following dialog screen:

![Database Recovery Configuration dialog](image)

**Figure 39**: Database recovery settings

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recovery cycle</td>
<td>The amount of time (in seconds) that the server uses to check for database connection status. If there is any connection problem, the server application tries to restore this connection (at least 30 s).</td>
</tr>
<tr>
<td>Log event file path</td>
<td>This is the full path of log event file used to trace database connections problems.</td>
</tr>
</tbody>
</table>

### 4.3 SERVER/LOG SETTINGS

You can configure some general server parameters like server frequency. You can also configure your logging parameters. To do so, click the **Options** menu and then choose the **General Settings** menu item (Figure 42).

![General settings dialog](image)

**Figure 40**: General settings
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>Corresponds to the <em>Server Rate</em> parameter in the ini file “DBSrv_CfgFile.ini” (at least 250 ms).</td>
</tr>
<tr>
<td>Launch server configuration at start-up</td>
<td>Corresponds to the <em>LoadConfigOnStartUp</em> parameter in the ini file “DBSrv_CfgFile.ini”.</td>
</tr>
<tr>
<td>Trace level</td>
<td>Corresponds to the <em>LogLevel</em> parameter in the ini file “DBSrv_CfgFile.ini”. The new loglevel will be taken in consideration in runtime.</td>
</tr>
<tr>
<td>Archive last log</td>
<td>Corresponds to the <em>ArchiveLastLog</em> parameter in the ini file “DBSrv_CfgFile.ini”. Any modification for this parameter will be taken into consideration in runtime.</td>
</tr>
<tr>
<td>Stop logging</td>
<td>To stop logging.</td>
</tr>
</tbody>
</table>

### 4.4 VIEW CONFIGURATION ERRORS

You can view the last configuration/database problems. To do so, select the “View” menu ➔ “Error messages” menu item.
1. CONFIGURING THE SERVER FOR DCOM

To set up the server

1. Logon with administrator privileges.

Choose Run from the Windows Start menu and type `DCOMCNFG` on the computer where your target OPC HDA Server for InSQL is running, then click `OK` to run the program for configuring DCOM.

The DCOM configuration utility looks like this:
Ensure that the Enable Distributed COM on this computer is enabled.
Configure the Default Authentication Level to be Connect.
Configure the Default Impersonation Level to be Identity.

2 Configure the Default Properties tab.

The Default Properties tab should look like this:
To configure DCOM settings for the OPC HDA Server for InSQL:

1. Click the **Application** tab in **DCOM Configuration** dialog and browse until you find the OPC HDA Server for InSQL.

2. Select the server and either right-click it or choose **Properties** to configure server-specific settings, as follows:

   a. On the **General** tab, we recommend that you leave the Authentication Level to be **Default**.
Figure 43: DCOM Configuration

b On the Location Tab, ensure that Run application on this computer is the only check box that is checked:
On the Security Tab, we recommend that you:

- Enable **Use default access permissions**, which means users/groups shown under the Default Security tab in the DCOM configuration utility will have access to connect to this OPC Server.
- Enable **Use default launch permissions**.

The same rules apply to using custom launch permissions here as they do to custom access permissions. If you choose to use the custom permissions to override the defaults, specify which users/groups to which you want to grant permissions.
The dialog looks like this:

![Security Tab](image.png)

**Figure 45**: Security Tab

**d** On the **Identity** Tab, specify under what user account you want the OPC HDA Server for InSQL to run.

This is probably one of the most important settings for the OPC HDA Server for InSQL, depending on how you will be using your system.

You do not need to configure anything on the **Endpoints** tab.

### 2. CONFIGURING THE CLIENT FOR DCOM

**To set up the client**

1. Launch the DCOM Config Utility.
2 Configure the **Default Properties** tab as you did on the server side.

3 Click the **Default Security** tab:

![Figure 46: Default Security](image)

This is where you configure who has access to your OPC client from remote OPC servers. You only need to be concerned with the Default Access Permissions button on this tab.

4 Under Default Access Permissions:

   Click the **Edit Default** button and configure the users of remote OPC servers whom you want to be able to make call-backs to this machine when your OPC client performs subscription-based read operations.

5 Configure the **Default Protocols** tab as you did on the server side.
Registering OPC HDA Server for InSQL:

To register the OPC HDA Server for InSQL on your client machine, you need to use a customized registry file. We shipped (*.reg) files for Windows NT 4.0, Windows XP professional and 2000 platforms. So, you just need to apply the appropriate file. Then, use the following steps to verify that the OPC HDA Server machine is properly delegated:

a. On the client machine, run the DCOM Config Utility.
b. Select your OPC HDA Server from the Applications tab and choose Properties.
c. On the General tab, be sure that there is an entry for Remote Computer and that the remote computer name is correct.
d. If the computer name is incorrect, select the Location tab.
e. Ensure the Run application on the following computer setting is checked.
   In the Dialog box beneath this selection, type in the correct computer name for your OPC HDA Server (see the figure below).
You can also use the following steps to verify the remote computer name by using the Windows Registry:

a. Run regedit.exe.

b. The remote server name is specified in the following registry key:

HKEY_CLASSES_ROOT\AppID\{The CLSID of the OPC server}\RemoteServerName
TROUBLESHOOTING

This section addresses some DCOM related problems while using OPC servers:

**Problem 1: You have an “Access denied” error on the client machine. The client and server are running on standalone machines (meaning not on the same domain).**

Let's assume that the OPC client is running on machine A and the OPC HDA Server on machine B.

When the OPC client and server are on different computers, you have to give each computer access to the other by giving access permissions. The permission issue is crucial to proper DCOM configurations.

Here the server is running on a standalone machine. So the ONLY user accounts it will trust are those it finds in its own "local" security database. Here is how this can get you into trouble when setting up an OPC client to server connection.

To allow a remote client to access the DCOM server, the DCOM utility uses a Windows Security database. For this reason, you cannot give access to a user account which is not found in this database.

Here is the issue:

1. You can add Machine B onto the same domain as Machine A (or in a trusted domain), which is the safest way to correctly set up communication between the OPC client and the OPC server.

2. You need to create the EXACT SAME user account name AND password on BOTH machines (for example User1 (login), PWD1 (password)). Once you have that set up, when Machine A comes calling on Machine B with an OPC request and identifies himself as User1 with PWD1 password, Machine B will
look in its database, see the same account name, the same password, and same "come on in request from Machine A". When Machine B goes to return its data from the OPC HDA Server to the OPC client on machine A, the OPC HDA Server will go call Machine A as User1 with a password -- Machine A will look in its database, see that it has that account, and accept the call. This workaround should resolve the communication problem between the OPC client and server.

**Problem 2: You have been running your OPC client on a Windows XP machine. When upgrading the machine to XP Service Pack 2, the OPC client becomes unable to connect to the OPC server.**

This is a common problem when using OPC via DCOM with Microsoft Windows XP Service Pack 2.

In fact, when Service Pack 2 is installed with its default configuration settings, OPC communication via DCOM will cease to work.

To resolve this issue, you have to reconfigure your settings for:
1- The windows XP firewall.
2- And DCOM.

Click on this link [Using OPC via DCOM with XP SP2.pdf](#) to download the OPC Foundation document that describes all steps to apply new settings.
1. Truncated data
In update methods like insert and update, data may be truncated if you choose a variant type different to the canonical one.
Example: Insert a value with data type = VT_UI2 knowing that the canonical data type is VT_I4.

Original value: 223355 → 26747

2. Server specific errors
Integration Objects defines the following error codes for this OPC server:

<table>
<thead>
<tr>
<th>Error code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IO_E_DB_STATE</td>
<td>A database problem has occurred: may be an exception or a broken connection.</td>
</tr>
</tbody>
</table>
For additional information on this guide, questions or problems to report, please contact:

**Offices**
- Houston, USA: +1 713 609 9208
- Genova, Italy: +39 34 75 83 93 47
- Tunis, Tunisia: +216 71 861 803

**Email**
- Support Services: customerservice@integrationobjects.com
- Sales: sales@integrationobjects.com

To find out how you can benefit from other Integration Objects products and custom-designed solutions, please visit us on the Internet:

**Online**
- www.integrationobjects.com